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Začíname s FreeMind 

Inštalácia z Internetu - http://freemind.sourceforge.net/wiki/index.php/Main_Page 

alebo na: http://www.slunecnice.cz/sw/freemind/ 

Inštalácia prebehne spustením súboru. Program nebude fungovať, ak nie je v počítači JAVA. Vieme 

to podľa toho, že v ovládacom paneli je „šálka s pariacou sa kávou“. 

Spustenie 

Po správnej inštalácii bude ikona programu na ploche. Ak o ikonu na ploche z rôznych dôvodov 

prídeme, program spustíme cez Start  Programy. 

Základy práce s programom 

o Otvoriť nový dokument – Subor  Nový (alebo cez aktívnu ikonu) 

o Otvoriť dokument – Subor  Otvoriť - otvárame v programe, nie cez príkazový riadom. JAVA 

programy majú takú výhodu, že uchovávajú všetky posledné dokumenty, ktoré potom vieme 

rýchlo otvoriť cez  Subor  Naposledy použité súbory.  

o Pomenovať mapu – Názov je v strede uzla, klikneme naň a prepíšeme ho. 

o Vložiť uzol – Použijeme ikonu žiarovka alebo  Vložiť   Nový poduzol. 

o Editácia uzla – Text v uzle editujeme dvojklikom na ľavé tlačidlo myši. To platí len pre uzly na 

konci vetvy. V ostatných prípadoch pomocou kliknutia skryjeme alebo odkryjeme nasledujúce časti 

vetvy. To je vhodné pri rozsiahlych diagramoch. 

Na editáciu používame kliknutie na uzol pravým tlačidlom myši, ktoré štandardne otvorí ponuku.  

o Vybrať tvar mapy  –  Jednotlivé uzly sa objavia na vetvách, alebo sú zatvorené v bublinách. 

Použijeme Formát  Bublina.  

o Spojiť uzly –  Uzly spájame, aby sme znázornili vzťah. Použijeme tzv. Drop and Draw  Pravým 

tlačidlom myši klikneme na uzol, z ktorého chceme viesť spojovaciu šípku a ťaháme na cieľový uzol 

(ten sa zafarbí na šedo). Po pustení tlačidla sa uzly spoja. Znova môžeme editovať pomocou myši. 

Klikneme ľavým tlačidlom na šípku a môžeme ju tvarovať. Pravé tlačidlo znova otvára ponuku.  

o Presúvať uzly – Poradie aktívneho uzla môžeme meniť pomocou klávesy Ctrl a šipky. Môžeme tiež 

použiť DaD a pomocou ľavého tlačidla premiestnime uzol na iné miesto. Miesto, na ktoré bude 

uzol napojený sa zafarbí na šedo.  

o Doplňovať diagram ikonami  – Pri aktívnom uzle klikneme na ikonu. 

o Meniť farby uzlov a vetiev  Použijeme Formát, alebo postupujeme ako pri editácii. 

 o Vkladať poznámky k uzlom – Poznámku môžeme vkladať len cez Vložiť  Poznámku. Vloženie 

poznámky nie je ponuke cez kliknutie myšou.  

o Rýchly návod – Použijeme Módy  Browse. Prehľadný návod je len v anglickom jazyku. 

o Export  – Pomocou exportu získame výstup v tvare textu, obrázku alebo vo formáte pdf. 

FreeMind neponúka také množstvo obrázkov ako drahé komerčné programy, ale je prehľadný 

a k používateľovi priateľský. 

http://freemind.sourceforge.net/wiki/index.php/Main_Page
http://www.slunecnice.cz/sw/freemind/
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1. Myšlienkové mapy v aplikácii FreeMind 

1. Čo sú to myšlienkové mapy, ich praktický význam  
2. Aplikácia FreeMind sa predstavuje  
3. Inštalácia aplikácie FreeMind  
    3.1 Java Runtime Environment  
    3.2 Inštalácia na systémoch Microsoft Windows  
 

1. Čo sú to myšlienkové mapy, ich praktický význam 

V súčasnej dobe sme svedkami rýchlych zmien či už v bežnom živote v práci a tiež vo 
vzdelávaní. Rýchle zmeny vyžadujú rýchle reakcie rýchle zaznamenanie nových udalostí 
a rýchle a efektívne učenie. Vo vyučovaní sa používajú nové metódy komunikácie ako je 
napr. brainstorming. Pri tomto princípe komunikácie, kde sa nepostupuje podľa vopred 
známej osnovy, je veľmi dôležité, aby boli vyslovené myšlienky vhodnou formou 
zaznamenané, a to čo najrýchlejšie, bez zbytočného zdržiavania sa. 

Jednou z foriem nelineárneho zápisu (či znázornenia) informácií sú aj myšlienkové mapy, 
ktorých princíp navrhol Tony Buzan. Princípom myšlienkových máp je voľný zápis kľúčových 
slov, celých textov, obrazov a ďalších informácií. Dôležité je, že tieto základné "informačné 
bloky" sú navzájom prepojené pomocou vizuálnych spojov a tvoria tak graf - väčšinou sa 
jedná o strom, v niektorých prípadoch sú však dovolené aj ďalšie väzby medzi uzlami grafu, 
ktoré čistú stromovú štruktúru narúšajú. Myšlienkové mapy značným spôsobom rozširujú 
možnosti textových editorov, v ktorých je umožnený len lineárny zápis. Rovnako ako vlastný 
zápis nových informácií je dôležitou vlastnosťou myšlienkových máp i spôsob ich 
prezerania. Jednotlivé uzly je totiž možné skrývať a znova rozbaľovať. Ak je nejaký uzol 
skrytý, sú automaticky skryté aj všetky jeho poduzly. Aj s veľmi zložitou myšlienkovú mapou 
je tak možné manipulovať aj na relatívne malej obrazovke. 

Použitie myšlienkových máp však nie je obmedzené len na brainstorming, vďaka skrývaniu 
uzlov sa tieto mapy hodia aj pre záznam a utriedenie myšlienok jedného samostatne 
pracujúceho či študujúceho človeka. Vhodné je napríklad použitie myšlienkových máp pri 
štúdiu; klasické poznámky sa totiž u zložitejšie látky stávajú neefektívne. Niektoré firmy tiež 
pomocou myšlienkových máp zaznamenávajú postupy pre svojich technických pracovníkov - 
uvádza sa, že takto použité myšlienkové mapy majú po vytlačení mnohokrát plochu 
niekoľkých metrov štvorcových. Na tomto mieste je vhodné si uvedomiť pomerne značný 
rozdiel medzi vytváraním myšlienkových máp (ktoré sú do značnej miery hierarchicky 
organizované) a napospol chaotickým písaním poznámok v štýle aplikácie One Note, aj keď 
aj tento typ aplikácií má celkom iste svoje uplatnenie. Prednosťou myšlienkových máp je to, 
že už pri ich vytváraní je používateľ nútený do presnejšieho členenia informácií. Táto 
počiatočná námaha sa však niekoľkonásobne vráti pri vyhľadávaní či ďalšom spracování 
informácií. 

 

Najbežnejšia forma na zaznamenávanie poznámok pomocou myšlienkových máp je 
kreslenie myšlienkovej mapy na jeden papier. 
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Efektívnejšie vytváranie myšlienkových máp umožňujú rôzne programy. 

  
Obrázok 1: Ukážka myšlienkovej mapy v programe FreMind 

 

2. Aplikácia FreeMind sa predstavuje 

Posledná verzia aplikácia FreeMind1.0.1 

 
Obrázok 2: Splashscreen aplikácie FreeMind 

3. Inštalácia aplikácie FreeMind 

Inštalácia programu FreeMind je popísaná v úvode. 

3.1 Java Runtime Environment  

K správnemu fungovaniu FreeMind je potrebná aplikácia JAVA, ak nie je na počítači 
nainštalovaná je potrebné ju nainštalovať zo stránky: https://java.com/en/download/ 

3.2 Inštalácia na systémoch Microsoft Windows 

     lišta s ikonami        hlavné menu  horná lišta nástrojov  kontextové menu 

 

Obrázok 3: FreeMind 1.0.1 na systéme Microsoft Windows 7 a 10  

https://java.com/en/download/
http://www.abclinuxu.cz/images/clanky/tisnovsky/freemind-1-01.png
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2. Myšlienkové mapy (užívateľské prostredie) 

1. Popis grafického užívateľského rozhrania aplikácie FreeMind 
2. Hlavné menu 
3. Kontextová menu 
4. Horná lišta nástrojov 
5. Ľavá lišta ikon 
6. Scrollbary 
7. Posun a zmena mierky mapy 

1. Opis grafického používateľského rozhrania 

Po spustení aplikácie FreeMind sa zobrazí hlavné okno programu, ktoré je rozdelené do 
niekoľkých oblastí. V hornej časti sa nachádza, podobne ako v ďalších aplikáciách s 
grafickým užívateľským rozhraním, položky z hlavného menu.  

Pod hlavným menu je zobrazený horná lišta nástrojov so základnými príkazmi určenými 
pre úpravu formátovania uzlov a textu zapísaného v uzloch.  

Na ľavej strane sa nachádza lišta s ikonami, ktoré je možné vkladať do uzla spolu s 
textom. Najväčšia časť hlavného okna zaberá pracovná plocha.  

Kontextové menu aktivujeme stlačením pravého tlačítka myši. 

Na obrázku 3 je ukážka grafického užívateľského rozhrania programu FreeMind 

 

2. Hlavné menu 

Hlavné menu programu FreeMind je na hornom okraji okna. Z celej štruktúry menu sa 
zobrazuje 9 najvyšších položiek, po ktorých výbere sa rozbalí celá štruktúra menu pod 
vybratou položkou: 

 Súbor obsahuje príkazy určené pre prácu so súbormi (vrátane importu a exportu do 
niekoľkých súborových formátov), príkazy pre tlač a tiež pre uzavretie myšlienkové 
mapy a tiež celej aplikácie. 

 Edituj obsahuje príkazy pre kopírovanie, vystrihnutie, editáciu uzlov a hrán, 
kopírovanie formátu. Príkazy z tohto menu sú dostupné aj z kontextových menu, 
ktoré budú opísané v ďalších odsekoch.  

 Pohľad obsahuje príkazy pre zobrazenie či skrytie oboch líšt a tiež príkazy pre 
zmenu mierky pohľadu na myšlienkovú mapu.  

 Vlož obsahuje príkazy pre vytváranie nových uzlov a poduzla, ako aj príkazy pre 
vkladanie ďalších objektov do myšlienkové mapy (poznámok, obrázkov, hyperlinkov a 
pod.).  

 Formát obsahuje príkazy pre formátovanie uzlov.  
 Naviguj umožnia pohyb myšlienkovú mapou, presun jednotlivých uzlov vpravo, 

vľavo, hore dole vrátane rozbaľovania a zbaľovania podstromov mapy. 
 Nástroje obsahuje ďalšie moduly, ktoré rozširujú možnosti celej aplikácie; napríklad 

sa jedná o zobrazenie modifikácie myšlienkovej mapy alebo jednoduchú správu 
verzií, kalendár, prepojenie dvoch uzlov.  

  Mapy obsahuje dynamicky sa meniaci zoznam otvorených myšlienkových máp, 
medzi ktorými sa dá veľmi jednoducho prepínať. Aj tento zoznam je dostupný 
pomocou kontextových menu. 

 Pomoc obsahuje odkazy na dokumentáciu a tiež FAQ. Zaujímavé je, že samotná 
dokumentácia je taktiež vytvorená ako myšlienková mapa, takže sú na nej 
prezentované prakticky všetky možnosti programu.  
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3. Kontextové menu 

Kontextových menu existuje vo FreeMind u niekoľko. Líšia sa samozrejme tým, pre aký 
objekt je menu vyvolané. Podobne ako u iných aplikácií, aj vo FreeMind u sa kontextové 
menu vyvoláva stlačením pravého tlačidla myši nad vybraným objektom či priamo nad 
pracovnou plochou aplikácie. 

Ak je pravé tlačidlo myši stlačené nad voľnou pracovnou plochou, objaví sa kontextové 
menu, v ktorom je možné zvoliť myšlienkovú mapu, ktorá sa má v ďalšom kroku prezerať či 
editovať. Táto časť kontextového menu teda supluje položku Mapy z hlavného menu. Okrem 
toho je možné z kontextového menu zapínať a vypínať hornú a ľavú lištu s ikonami. 

Druhé významné kontextové menu sa zobrazí v prípade, že je pravé tlačidlo myši stlačené 
nad určitým uzlom v myšlienkovej mape. Zo zobrazeného menu je možné uzly prenášať cez 
schránku, meniť vlastnosti uzlov a v neposlednom rade tiež meniť vlastnosti hrán, ktoré uzly 
navzájom spájajú. Toto kontextové menu nahrádza veľkú časť príkazov, ktoré sú dostupné z 
položiek Edituj , Vlož a Formát hlavného menu. 

 

4. Horná lišta nástrojov 

Pod hlavným menu sa nachádza horná lišta (nástrojová lišta), ktorý obsahuje ikony so 
základnými editačnými a formátovacími príkazy. Túto lištu je možné zviditeľniť či zneviditeľniť 
pomocou kontextového menu, ktoré sa zobrazí po stlačení pravého tlačidla myši na 
pracovnej ploche aplikácie. Hornú lištu je tiež možné pomocou myši pretiahnuť na iné miesto 
v pracovnom okne, alebo ju možno dokonca rozdeliť na viac relatívne samostatných častí. 

 Význam jednotlivých ikon je nasledujúci: 

Vytvorenie novej myšlienkové mapy. Medzi jednotlivými mapami sa dá prepínať buď 
pomocou kontextového menu alebo pomocou dvoch (väčšinou modrých) šípok alebo 

pomocou záložiek zobrazených taktiež na hornej lište. Novú myšlienkovú mapu je možné 

taktiež vytvoriť cez klávesovú skratku Ctrl + N . 

Otvorenie súboru s myšlienkovú mapou. Rovnakú operáciu možno vykonať z hlavného 

menu alebo pomocou klávesovej skratky Ctrl + O . 

Uloženie myšlienkové mapy do externého súboru. Túto operáciu možno tiež vykonať 

pomocou klávesovej skratky Ctrl + S . Myšlienková mapa je v externom súbore 

uložená vo formáte XML. 

Uloženie myšlienkovej mapy do externého súboru pod iným menom. Po zadaní tohto 
príkazu sa aplikácia pomocou štandardného dialógového okna pre výber súboru spýta 

na meno a umiestnení novo vytváraného súboru, klávesová skratka Ctrl + Shift+ S . 

Vybratie aktívneho uzla či vybraných uzlov a vloženie do schránky (clipboardu). Ak sa 
vykoná vloženie uzla či uzlov do inej aplikácie, prenesie sa do tejto aplikácie text vnútri 

uzla. Podobnú operáciu možno vykonať pomocou klávesovej skratky Ctrl + X s tým 

rozdielom, že túto skratku možno použiť aj pri editácii na časť vybraného textu. Ikona však 
pracuje iba s celými uzlami. 

Skopírovanie aktívneho uzla či vybraných uzlov do schránky (clipboardu). Táto operácia 
je podobná ako operácia predchádzajúca s tým rozdielom, že sa uzly z myšlienkovej 

mapy nevyberú. Podobnú operáciu zaistí aj klávesová skratka Ctrl + C . 

Vloženie uzla zo schránky (clibboardu) do myšlienkové mapy. Ak je v schránke 
umiestnený text (napríklad z textového editora alebo webového prehliadača), je 

vytvorený nový uzol a text je vložený do tohto uzla. Viacriadkový text v schránke je možné 
použiť pre vytvorenie viacerých uzlov. Obdobnú operáciu možno vykonať pomocou 

klávesovej skratky Ctrl + V . 

Pomocou tejto ikony alebo klávesové skratky Ctrl + I sa zmení text v uzle či vo 

vybraných uzloch na italikom (kurzíva). Ďalšie stlačenie tejto ikony spôsobí navrátenie 
operácie. 
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Táto ikona slúži na zapnutie alebo vypnutie tučného písma. Rovnakú operáciu možno 

vykonať pomocou klávesovej skratky Ctrl + B . 

Po výbere tejto ikony sa vykoná vyznačenie aktívneho uzla či vybraných uzlov pomocou 
"obláčikov". Týmto spôsobom možno zvýrazniť určitej časti myšlienkové mapy. Oblaky 

možné zapínať a vypínať aj pomocou trochu krkolomné klávesovej skratky Ctrl + Shift 

+ B . 

Tento ovládací prvok slúži na výber písma, ktoré je použité v aktívnom 
(práve vybranom) uzla. Pre túto činnosť nie je vyhradené žiadna 

klávesová skratka. Po rozbalení tohto ovládacieho prvku sa samozrejme zobrazí iba tá 
písma (fonty), ktoré sú na danom systéme dostupná. Pri skopírovanie myšlienkové mapy do 
iného systému môžu nastať problémy s prevodom neexistujúcich fontov. 

Týmto ovládacím prvkom je možné meniť veľkosť písma v aktívnom uzle či 

uzloch. Veľkosť písma možno tiež meniť pomocou klávesových skratiek Ctrl 

+ L (zväčšiť písmo) a Ctrl + M (zmenšiť písmo). 

5. Ľavý toolbar 

Na ľavom toolbaru, ktorý je samozrejme taktiež premiestniteľný, sa nachádzajú ikony, ktoré 
možno vkladať do aktívneho (práve vybraného) uzla. Použitie tohto toolbaru je jednoduché - 
po vybraní uzla sa ľavým tlačidlom myši klikne na niektorú z ikon, ktorá sa potom do uzla 
vloží. V uzle môže byť ikon hneď niekoľko, ale po ich vložení je už nie je možné 
premiestňovať, len je možné odobrať a znovu pridať v inom poradí. Prvé dve ikony na ľavom 
toolbaru však majú špeciálny význam. 

Po stlačení prvej ikony sa z aktívneho uzla vymaže naposledy vložená ikona - jedná sa 
tak o jednoduchý editačný príkaz. 

Tento príkaz slúži na odobratie všetkých ikon z aktívneho uzla. 

Poznámka: v ikonách je dostupný aj pekný tučňáček, okná s obláčiky však budete hľadať 
márne :-). 

6. Scrollbary 

Scrollbary sú väčšinou umiestnené po pravej a dolnej strane pracovnej plochy aplikácie. Ich 
použitie je triviálne - pomocou nich je umožnený posun po ploche, na ktorej je vytvorená 
myšlienková mapa. Činnosť scrollbaru je možno nahradiť aj kolieskom myši. Pri prostom 
rolovaní kolieskom sa vykonáva vertikálny posuv myšlienkovej mapy, pri rolovaní so 

stlačenou klávesou Shift či niektorom z tlačidiel myši sa robí rolovanie horizontálne. 

7. Posun a zmena mierky mapy 

Posun mapy bol už popísaný v predchádzajúcej podkapitole, tu si však popíšeme aj ďalšie 
možnosti zmeny pohľadu na myšlienkovú mapu. Mapu je možné v okne aplikácie posúvať 
tromi spôsobmi: 

1. stlačením ľavého tlačidla myši na pracovnej ploche (mimo uzlov) a posunom myši 

2. pomocou rolovacieho kolieska na myši s prípadným použitím klávesu Shift či 

niektorého tlačidla myši 
3. pomocou scrollbar, ktoré sú umiestnené po pravej a dolnej strane pracovnej plochy 

aplikácie 

Zmenu mierky zobrazenej myšlienkové mapy je taktiež možné vykonať viacerými 
spôsobmi. Najjednoduchšie je použitie rozbaľovacieho zoznamu umiestneného na hornej 
lište, po ktorého rozbalení je možné zvoliť z niekoľkých zväčšenín myšlienkovej 

mapy. Druhou možnosťou je stlačenie Ctrl a posunom kolieska myši. 
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3. Myšlienkové mapy ovládanie aplikácie FreeMind  

1. Operácie s uzlami myšlienkovej mapy 
    1.1 Vytváranie a rušenie uzlov 
    1.2 Editácia uzlov 
    1.3 Hypertextové odkazy a obrázky 
    1.4 Štýl písma a formátovanie celého uzla 
    1.5 Ikony vkladané do uzlov 
2. Operácie s hranami myšlienkové mapy 
    2.1 Štýl hrán 
    2.2 Farba hrán 
    2.3 Hrúbka hrany 
    2.4 Vyhladenie hrán 
    2.5 Prídavné hrany 
 

1. Operácie s uzlami myšlienkové mapy 

Pri tvorbe a následnej úprave myšlienkovej mapy sú jednou z najdôležitejších činností 
operácie vykonávané s jednotlivými uzlami mapy. FreeMind používa techniku automatického 
umiestňovanie uzlov v pracovnej ploche, čo znamená, že užívateľ iba špecifikuje vzťah novo 
vytváraného uzla k uzlom ostatným. Nové uzly možno vytvárať na dvoch miestach: buď sa 
jedná o uzly na rovnakej úrovni, ako je uzol aktívny, alebo sa jedná o poduzol, tj. O uzol na 
nižšej úrovni. Po vytvorení uzlov je možné začať s úpravami myšlienkové mapy. Uzly možno 
premiestňovať, meniť ich hierarchiu (vzájomné väzby) a štýl, prepisovať časti textu v uzloch, 
pracovať s hypertextovými odkazy a obrázky a pod. Všetky tieto možnosti budú spomenuté v 
nasledujúcich podkapitolách. 

1.1 Vytváranie a rušenie uzlov 

Pre vytvorenie nového poduzlu stačí použiť kláves [Insert] . Po stlačení tohto klávesu sa 

vytvorí nový poduzel, do ktorého je ihneď možné zapisovať nový text alebo vkladať 
predpripravené ikony. To, že je možné do uzla zapisovať text, je symbolizované textovým 
kurzorom, ktorý sa v uzle objaví. Uzol sa v tejto chvíli chová ako systémové textové pole, 
takže je napríklad možné pracovať zo schránkou (clipboard) apod. Nový uzol možno tiež 
vytvoriť pomocou kontextového menu, z ktorého sa vyberie príkaz Nový poduzol . 

Uzol na rovnakej úrovni v mape sa vytvorí po zatlačení klávesy [Enter] . Tiež po vytvorení 

tohto uzla je možné do neho ihneď zapisovať informácie. Po zatlačení klávesové 

kombinácie [Shift] + [Enter] sa taktiež vytvorí nový uzol na rovnakej úrovni v 

hierarchii, ale tento uzol bude umiestnený nad aktívnym uzlom, nie pod ním. Aj tieto dva 
príkazy sú dostupné z hlavného i kontextového menu pod položkami Vlož-> Nový 
súrodenecký uzol a Vlož-> Nový predchádzajúci súrodenecký uzol. 

Ak sa po zápise nového textu do uzla stlačí iba klávesa [Enter] , bude nový uzol 

obsahovať len jeden riadok textu. Je však možné vytvárať aj uzly s dlhšími (odstavcovými) 
texty - také uzly sa vo FreeMind u nazývajú "dlhej uzly" a sú vytvorené tak, že sa po zadaní 

prvého riadku textu do uzla stlačí namiesto jednoduchého [enter] kombinácie 

klávesov [Alt] + [Enter] . Po tomto príkaze sa otvorí malé okno s textovým poľom, do 

ktorého je možné zapísať niekoľkoriadkový text. O odstavcový text sa jedná z toho dôvodu, 
že sa koniec riadku musí špecifikovať iba tam, kde je potrebné ukončiť odsek. Vstavaný 
textový editor automaticky ukončuje riadky podľa šírky okna a pritom na ďalšie (obrazové) 
riadky presúva celé slová. 

Pri zápise textu do "dlhého uzla" sa pre ukončenie jednotlivých riadkov používa buď 

iba [Enter] alebo klávesová kombinácia [Ctrl] + [Enter] . Konkrétne správanie 

aplikácie závisí od nastavenia zatrhávacího boxe "Enter confirms", ktorý podľa užívateľovho 

zvyku prehadzuje význam klávesových skratiek [Enter] a [Ctrl] + [Enter] . Text v 

"dlhom uzle" môže obsahovať aj tabelačné zarážky, týmto spôsobom je možné do 
myšlienkovej mapy vkladať aj jednoduché tabuľky bez nutnosti viazať uzol myšlienkovej 
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mapy na externý súbor. Texty vkladané do uzlov je možné prenášať aj cez schránku 
(napríklad z textového editora alebo internetového prehliadača. V tomto prípade, sa každý 
riadok textu vloží do nového uzla. 

O rušenie uzlov sa postará klávesa [Delete] . Stlačením tohto klávesu je možné vymazať 

aj celý podstrom. Naproti tomu klávesa [BackSpace] slúži na vymazanie textu z uzla a 

prepnutie aplikácie do režimu, v ktorom je možné do práve aktívneho uzla zapísať nový text.  

1.2 Editácia uzlov 

Základným editačnom príkazom je samozrejme zmena textu, ktorý je v uzle uložený. Po 

výbere niektorého uzla možno stlačiť kláves [F2] , po ktorej stlačení sa celá aplikácia 

prepne do režimu zmeny textu v uzle, čo je symbolizované textovým kurzorom, ktorý sa v 
uzle objaví. Teraz sa tiež zmení funkcia niektorých klávesov, najmä klávesov pre posun 

kurzora ( [šípka doľava] , [šípka doprava] , [Home] a [End] ) a pre prácu so 

schránkou. Tieto klávesy teraz fungujú tak, ako je to bežné v textových editoroch. 

Pri editácii "dlhého uzla" (pozri predchádzajúci podkapitola) sa otvorí samostatné okno, v 

ktorom je možné úpravy vykonávať. Nastavenie klávesových skratiek [Enter] a [Ctrl] + 

[Enter] zostáva nastavené rovnako, ako pri vytváraní nového uzla. V okne, ktoré sa otvorí 

pre editáciu dlhého uzla možno použiť aj ďalšiu užitočnú operáciu nazvanú Rozdeľ , 
pomocou ktorej je možné uzol rozdeliť na dva uzly. Iba stačí prejsť textovým kurzorom na 
miesto rozdelenie a stlačiť tlačidlo Rozdeľ - časť textu pred kurzorom sa stane jedným uzlom, 
zvyšný text sa stane uzlom druhým. Postupným použitím operácie Rozdeľ a presunom uzlov 
je do myšlienkovej mapy možné dostať pôvodne lineárny text, čo ho mnohokrát sprehľadní a 
urýchli jeho pochopenie. 

Ďalším často používaným editačnom príkazom je presun uzla na iné miesto v myšlienkovej 
mape. Tento príkaz je možné vykonávať ako pomocou klávesnice, tak aj pomocou myši. Pre 
presun uzla hore či dole na rovnakej úrovni hierarchie je možné použiť klávesové 

skratky [Ctrl] + [šípka hore] a [Ctrl] + [šípka dole] . Rovnakú operáciu je 

možné vykonať ťahaním uzla pomocou myši. Nové umiestnenia uzla je indikované 
gradientným prechodom - viď ilustračné obrázky zobrazené nižšie. 

 
 

Obrázok 1: Presun uzla číslo 1 na rovnakú úroveň v hierarchii 
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Obrázok 2: Stav po presunutí uzla číslo 1 

Pokiaľ je nutné presunúť uzol na ľubovoľné (i dosť vzdialené) miesto v myšlienkovej mape, je 

použitie klávesnice obmedzené na prácu so schránkou, tj. Na klávesové skratky [Ctrl + 

X] , [Ctrl + C] , [Ctrl + V] , čo je trochu ťažkopádne. V tomto prípade je oveľa 

výhodnejšie použiť myš a uzol na požadované miesto pretiahnuť ( drag ) so stlačeným ľavým 
tlačidlom. Pokiaľ je potrebné pretiahnuť uzol na inú úroveň hierarchie, musí sa kurzor myši 
umiestniť na miesto, kde sa objaví horizontálny gradientný prechod. Uvedená operácia je 
znázornená na ďalších dvoch ilustračných obrázkoch. 

 
 

Obrázok 3: Presun uzla číslo 1 na odlišnú úroveň v hierarchii 

 
 



10 
 

Obrázok 4: Stav po presunutí uzla číslo 1 

Manuálny presun uzla sa robí nasledovne: kurzor myši sa umiestnia k ľavému okraju uzla 
tak, aby sa u kurzora zobrazila malá elipsa. Túto elipsu je možné pomocou ľavého tlačidla 
"chytiť" a uzol následne presunúť. Spolu s presúvaným uzlom sa dynamicky mení aj časť 
myšlienkové mapy v okolí uzla tak, aby sa dodržala stanovená hierarchia, tj. Aby presúvaný 
uzol nepreskočil svojho predchodcu alebo následníka. Pomocou príkazu Format-> Vráť 
pozíciu je uzol vrátený do svojej počiatočnej pozície. Ukážka manuálneho presunu uzla je 
ukázaná na piatom a šiestom obrázku. 

 
 

Obrázok 5: Kurzor myši v mieste, kde môže dôjsť k manuálnemu presunu uzla 

 
 

Obrázok 6: Manuálna presun uzla 

1.3 Hypertextové odkazy a obrázky 

Do uzlov možno okrem jednoriadkového či odstavcového textu vkladať aj hypertextové 
odkazy a obrázky. Vkladanie hypertextových odkazov je jednoduché. Stačí vybrať niektorý 

uzol a stlačiť klávesovú skratku [Ctrl] + [K] . Objaví sa dialógové okno, do ktorého 

možno napísať (alebo preniesť cez schránku napríklad z internetového prehliadača) URL, tj. 

Celú cestu hypertextového odkazu. Pomocou klávesovej kombinácie [Ctrl] + [Shift] 

+ [K] je možné vyvolať dialógové okno, v ktorom je možné URL vybrať, takže sa odkaz 

nemusí vypisovať ručne. Uzol, ktorý obsahuje hypertextový odkaz, má na svojej ľavej strane 
zobrazenú šípku. Po kliknutí ľavým tlačidlom na šípku sa vykoná skok na hypertextový 
odkaz, kliknutie do iných častí uzla spôsobí zobrazenie či skrytie poduzla. Skok na 

hypertextové prepojenie je možné vykonať aj z klávesnice klávesovou skratkou [Ctrl] + 

[Enter] . 

Pre vkladanie obrázkov je možné použiť klávesovú skratku [Alt] + [K] . Po stlačení tejto 

kombinácie klávesov sa objaví dialógové okno, pomocou ktorého možno obrázok 
nalistovať. Pri tomto spôsobe výbere obrázku sa do uzla zapíše jednoduchý kód v jazyku 
HTML, ktorý obsahuje odkaz na zobrazovaný obrázok. Kód je možné samozrejme opraviť 

(klávesom [F2] ) a ručne zmeniť napríklad rozmery obrázku. U obrázkov musíme mať 

ďalej na mysli, že do súboru s myšlienkovú mapou sa ukladajú iba ODKAZY na 
obrázky a nie samotné bitmapy. Pri posielaní či presune súboru s myšlienkovú mapou 
je nutné túto skutočnosť vziať do úvahy, inak sa odkazy na obrázky "rozsypú". Ukážka 
myšlienkovej mapy s vloženými obrázkami je ukázaná na obrázku 7. 

http://www.abclinuxu.cz/images/clanky/tisnovsky/freemind3_05.png
http://www.abclinuxu.cz/images/clanky/tisnovsky/freemind3_06.png
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Obrázok 7: Myšlienková mapa s vloženými obrázkami 

1.4 Štýl písma a formátovanie celého uzla 

Text v uzle môže byť rôznym spôsobom naformátovaný a môžu mu byť pridelené rôzne 
fonty. Najjednoduchšie je použitie hornej lišty, ktorá obsahuje prakticky všetky príkazy pre 

formátovanie textu v uzla. Pomocou príslušných ikon alebo klávesových skratiek [Ctrl] + 

[B] a [Ctrl] + [I] je možné zapínať a vypínať tučný text, popr. kurzívu. Na hornej lište 

sa rovnako nachádzajú rozbaľovacie boxy, v ktorých je možné vybrať veľkosť textu a použitý 
font. Výber dostupných fontov je samozrejme závislý na fontoch, ktoré sú nainštalované v 
systéme, samotný FreeMind žiadne vlastné fonty neobsahuje. 

Ďalším atribútom uzlov, ktorý možno zmeniť, je farba pozadia a textu. Uzly môžu mať okolo 
seba zobrazený okraj - to sa robí príkazom Vlož-> Oblak . 

1.5 Ikony vkladané do uzlov 

Ikony môžu v niektorých prípadoch uľahčiť orientáciu v rozsiahlych myšlienkových mapách, 
rovnako tak ako farby a štýly písma jednotlivých uzlov. Vloženie ikony do uzla je veľmi 
jednoduché. Stačí vybrať niektorú ikonu ponúkanú na ľavej lište a táto ikona sa vloží do 
práve aktívneho uzla. Ak je ľavá lišta vypnutá, možno použiť aj kontextové menu, ktoré sa 
zobrazí kliknutím pravým tlačidlom myši na niektorom z uzlov. Z tohto menu stačí zvoliť 
príkaz Icons a rozbalí sa submenu s názvami a náhľady jednotlivých dostupných ikon. V 
súčasnej verzii FreeMind nie je možné používať vlastné ikony, namiesto nich sa do uzlov 
dajú vkladať odkazy na obrázky (bitmapy i pixmap) uložené v externých súboroch - pozri 
prechádzajúci text, najmä podkapitola 1.3. 

Pomocou dvoch príkazov je možné odstrániť buď poslednú zadanú ikonu alebo všetky 
ikony. Príkaz Ikony-> Odstráň poslednú ikonu odstráni posledné vloženú ikonu, ktorá je 
umiestnená napravo. Príkaz Ikony-> Odstráň všetky ikony odstráni všetky ikony v 
uzle. Žiadne ďalšie operácie s ikonami nie sú podporované, takže napríklad prehodenie 
dvoch ikon sa musí vykonávať ich odstránením a opätovným vložením. 

2. Operácie s hranami myšlienkové mapy 

Každá myšlienková mapa sa okrem uzlov skladá aj z hrán (na tomto mieste sa nenechajte 
zmiasť pomenovaním mapa, z matematického pohľadu sa vlastne jedná o orientovaný 
graf). Operácie, ktoré je možné s hranami vykonávať, budú uvedené v nasledujúcich 
podkapitolách. 

2.1 Štýl hrán 

Hrany môžu byť v súčasnej verzii zobrazené štyrmi rôznymi spôsobmi. Najpoužívanejším 
štýlom je klasická úsečka s konštantnou šírkou, ktorá je použitá aj u ďalších aplikácií 
spracovávajúcich myšlienkové mapy. Ďalším štýlom je úsečka s premenlivou šírkou, ktorá 
tak čiastočne nahrádza šípky. Nasleduje hrana v tvare Bézierove Kubík (tj. Krivky určenej 

http://www.abclinuxu.cz/images/clanky/tisnovsky/freemind3_07.png
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pomocou štyroch riadiacich bodov alebo dvoch bodov a dvoch dotyčníc) a konečne hrana v 
tvare Bézierove Kubík s premenlivou šírkou, podobne ako u úsečiek. Štýl hrán v 
myšlienkovej mape sa vyberá z hlavného či kontextového menu Format-> Štýl hrany . Hrany 
sa zmenia len pre podstrom špecifikovaný práve aktívnym uzlom (alebo pre viac 
podstromov, ak je uzlov vybraných niekoľko). 

2.2 Farba hrán 

Farby hrán (ale i okrajov uzlov) je možné meniť príkazom Format-> Farba hrany vyvolaný z 
hlavného či kontextového menu. Podobne ako u zmeny štýlov hrán, aj ich farby sa zmení iba 
v podstrome prislúchajúcim k aktívnemu uzlu či aktívnym uzlom. 

2.3 Hrúbka hrany 

Hrúbku hrán je možné meniť príkazom Format-> Hrúbky hrán . Hrúbka sa zadáva v pixeloch, 
pričom sa samozrejme nejedná o presne zadanú hodnotu, pretože hrany sú zobrazované 
pod rôznym sklonom, popr. aj so zapnutým vyhladzovaním. Ak sú použité také štýly hrán, že 
u nich dochádza k zužovaniu, platí zadané hrúbka hrán pre ich hrubšie začiatok, tenší 
začiatok je vždy nastavený na jeden pixel. 

2.4 Vyhladenie hrán 

Vyhladenie hrán, ktoré je vhodné zapnúť najmä pri práci na LC displejoch, sa zapína 
pomocou voľby dostupné na formulári Preferences , ktorý možno vyvolať buď z hlavného 
menu, alebo pomocou klávesovej skratky [Ctrl] + [,]. Voľba pre vyhladzovanie sa volá 
"Appearance / antialias". 

2.5 Prídavné hrany 

Myšlienkové mapy tvoria z matematického hľadiska stromovú štruktúru. V niektorých 
prípadoch je však vhodné do mapy zaviesť aj iné väzby, ktoré čistý strom porušujú a 
"povyšujú" ho na všeobecný graf. Vo FreeMind sa ďalšie väzby vytvára buď pomocou 

klávesnice (klávesová skratka [Ctrl] + [L] , alebo myšou, a to tak, že sa väzba vytvorí 

ťahaním kurzoru myši sa stlačeným ľavým tlačidlom myši a súčasne klávesmi [Ctrl] + 

[Shift] . výsledná myšlienková mapa s ďalšími väzbami je zobrazená na ďalšom obrázku. 

 
Obrázok 8: Myšlienková mapa s pridanými väzbami medzi uzlami 
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4. Myšlienkové mapy export inport 

1. Prenos dát medzi FreeMind a ďalšími aplikáciami 
2. Možnosti exportu myšlienkových máp alebo ich častí 
    2.1 Export myšlienkové mapy do HTML a XHTML 
    2.2 Export myšlienkové mapy do formátu PDF 
    2.3 Export myšlienkové mapy do bitovej mapy 
3. Možnosti importu myšlienkových máp 
    3.1 Import ďalšie myšlienkové mapy 
    3.2 Import adresárovej štruktúry 
    3.3 Import záložiek z programu Internet Explorer 
    3.4 Import dát z aplikácie MindManager 
4. Formát súborov programu FreeMind 
 

1. Prenos dát medzi FreeMind a ďalšími aplikáciami 

Aplikácia FreeMind obsahuje pri komunikácii s ďalšími aplikáciami prekvapivo veľa 
možností. Ide tak o prenos dát pomocou schránky (clipboardu), tak aj o exporty a importy dát 
do rôznych súborových formátov. Vo druhej kapitole budú popísané možnosti exportu a 
v  tretej možnosti importu častí myšlienkových máp.  

2. Možnosti exportu myšlienkových máp alebo ich častí 

Z  FreeMind je možné vykonať export vytvorené myšlienkové mapy do niekoľkých 
formátov. Najčastejšie používaný bude pravdepodobne export do HTML súboru 
prehliadateľných takmer v akomkoľvek WWW browsera, je však možné generovať aj statické 
dokumenty vo formátoch PDF alebo rastrové aj vektorové obrázky typu JPG PNG a JFIF 

Druhý príkaz pre export ( File-> export-> As XHTML JavaScript Version ) je v mnohom 
podobný predchádzajúcemu príkazu. Namiesto HTML súboru je však vytvorený korektné 
súbor typu XHTML. Spolu s týmto súborom je vytvorený aj podadresár s názvom rovnakým 
ako súbor XHTML a navyše s pridaným reťazcom "FILES".   

Tretí príkaz pre export do HTML je ( File-> export-> As XHTML clickable Map Version ). 

2.2 Export myšlienkové mapy do formátu PDF 

V niektorých prípadoch, napríklad pri potrebe tlače myšlienkovej mapy na inom počítači, sa 
môže hodiť export myšlienkové mapy do formátu PDF ( Portable Document 
Format ).Myšlienková mapa vyexportované do tohto formátu je však statická, tj. Spôsob jej 
zobrazenie už nie je možné zmeniť. Na druhú stranu je myšlienková mapa zobrazená presne 
v tej podobe ako v samotnom FreeMind . Formát PDF je tu využitý veľmi rozumným 
spôsobom, obrázok myšlienkovej mapy je striktne vektorový, takže výsledný súbor je 
relatívne malý a pritom je zaistený pre kvalitnú tlač na prakticky všetkých tlačiarňach.  
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Obrázok 6: Myšlienková mapa prevedená do formátu PDF zobrazené v Acrobat Reader 

2.3 Export myšlienkové mapy do bitovej mapy 

Myšlienkovú mapu je možné vyexportovať aj do bitovej mapy. V tomto prípade sa však 
musíme zmieriť s tým, že výsledné súbory budú (napriek použitým formátom s dobrou 
kompresiou obrazových dát) objemné a tlač mnohokrát nekvalitné či problematický. V 
súčasnej verzii FreeMind sú pre export podporované rastrové obrázky uložené vo formáte  
JPEG a PNG ( Portable Network Graphics ).  

3. Možnosti importu myšlienkových máp 

Import myšlienkových máp je vo FreeMind prepracovaný rovnako dobre ako export 
dát. Myšlienkové mapy je možné navzájom spájať, načítať adresárovú štruktúru alebo 
naimportovať záložky vo formáte programu Internet Explorer. Podrobnosti o importe sú 
uvedené v ďalších podkapitolách. 

3.1 Import ďalšie myšlienkové mapy 

Aplikácia FreeMind umožňuje, aby sa veľmi jednoduchým spôsobom dali vzájomne zlúčiť 
dve alebo viac myšlienkových máp. Po výbere príkazu File-> Import-> Branch sa zobrazí 
výzva výber ľubovoľného súboru s uloženou myšlienkovú mapou (jedná sa o súbory s 
koncovkou .mm). Vybraná myšlienková mapa sa vloží do existujúcej (tj. Práve editované) 
myšlienkové mapy tak, že sa stane súčasťou aktívneho uzla. 

3.2 Import adresárovej štruktúry 

Po zadaní príkazu File-> Import-> Folder Structure sa zobrazí dialóg umožňujúci výber 
ľubovoľného adresára. Po potvrdení výberu nejakého adresára sa do práve editované 
myšlienkové mapy vloží uzly, ktoré daný adresár (a samozrejme aj prípadné podadresára) 
graficky reprezentujú. Týmto spôsobom je možné vykonať rýchly náhľad na adresárovú 
štruktúru - výsledok je podobný výstupu z príkazu strom . 

3.3 Import záložiek z programu Internet Explorer 

Nasledujúci príkaz, ktorý je vlastne obdobou príkazu predchádzajúceho, umožňuje načítať a 
spracovať dáta z adresára, v ktorom sú obsiahnuté záložky WWW prehliadača Internet 
Explorer. Tento WWW prehliadač (ale nielen on, aj ďalšie prehliadače tento formát záložiek 
môžu spracovať, napríklad formou importu a exportu) ukladá každú záložku do 

http://www.abclinuxu.cz/images/clanky/tisnovsky/freemind4_6.png
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samostatného súboru s koncovkou .url. V tomto súbore, ktorého štruktúra je podobná 
súborom typu .ini, je uložený odkaz na nejakú HTML stránku pomocou unifikovaného 
lokátora, ďalej je tu uložený čas poslednej modifikácie súboru a prípadne aj ďalšie informácie 
potrebné napríklad pre správny odkaz na stránku zobrazenú v rámčekoch. Po zadaní 
príkazuFile-> Import-> Explorer Favorites sa zobrazí dialóg pre výber adresára, v ktorom sú 
uložené záložky - FreeMind teda nedokáže zo systémovej konfigurácie automaticky zistiť, 
kde sú záložky uložené (to však používateľom Linuxu úplne nemusí vadiť). Vybraný súbor sa 
importuje tak, že novo vytvorené uzly obsahujú okrem svojho popisného textu aj odkaz 
(URL) na danú stránku. 

3.4 Import dát z aplikácie MindManager 

Príkazom File-> Import-> MindManager Map je možné vykonať import dát z 
aplikácie MindManager . Importuje sa vždy celá myšlienková mapa, ktorá je následne 
pripojená k práve editované mape, podobne ako u vyššie popísaných importov adresárovej 
štruktúry a záložiek. 

4. Formát súborov programu FreeMind 

FreeMind ukladá myšlienkové mapy do súborov s koncovkou *.mm.   

 


